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 قدمةم

وعلى آلة  بن عبد الله محمدوالصلاة والسلام على من لا نبي بعده، الحمد لله وحده 

 وصحبه، وبعد:

من منطلق حرص المؤسسة العامة للتدريب التقني والمهني وتماشيا مع تحقيق رؤية التحول 

الوطني والمساهمة في الخدمة المجتمعية رأت أن تتقدم خدمات تدريبية بعض الحقائب التدريبية 

ساعة تدريب في  16تتجاوز  بشكل مُبسط في محتوى تدريبي تقديمه في دورات قصيرة لا

الأسبوع، تُقدم لجميع شرائح المجتمع الراغبين في اكتساب مهارات في أحد التخصصات التي 

 تهمهم في حياتهم اليومية.

برامج لمتدربي  " التصميم بالفوتوشوب والإليستريتور "هذه الحقيبة التدريبية  وتتناول

لهذا  الثقافة المهنية واكتساب المهارات الأوليةموضوعات حيوية تتناول  التدريب المجتمعي 

 .التدريبي البرنامج

 لمناهج وهي تضع بين يديك هذه الحقيبة التدريبية تأمل من الله عز وجلًلوالإدارة العامة 

مباشر في تأصيل المهارات الضرورية اللازمة، بأسلوب مبسط يخلو من  الشكلأن تسهم ب

 كال التي تدعم عملية اكتساب هذه المهارات. بالتطبيقات والأش مدعمالتعقيد، 

إنه سميع  المستفيدين منها لما يحبه ويرضاه،والله نسأل أن يوفق القائمين على إعدادها و

 مجيب الدعاء.

 

 

 

 لمناهجلالإدارة العامة               
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 6 مقدمة
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 7 قوائم الأوامر

 12 فتح ملف

 12 صندوق الأدوات

 15 اختصارات لوحة المفاتيح
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 17  كيفية الانتقاء
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 تمهيد

 الحقيبة:الهدف العام من 

التصدددميم الأساسدددية في والمعلومدددات المهدددارات  المتددددربإلى إكسددداب  البرندددامجيهددددف هدددذا 

 .بالفوتوشوب والإليستريتور

 بالحقيبة:تعريف 

 ،التصدميم بالفوتوشدوب والإليسدتريتور   عدن  تقدم هذه الحقيبة المفاهيم الأولية الأساسدية   

أدوات البرندامج، يتعامدل   التعدرف علدى واجهدتي الدبرامج، يسدتخدم       مدن  المتددرب مكن سيت حيث

   .مع الطبقات والمؤثرات ، يرسم الأشكال والشعارات ، ويحفظ الصور بالصيغ مختلفة

 التدريبية:الوقت المتوقع لإتمام التدريب على مهارات هذه الحقيبة 

 كالتالي:موزعة  تدريبية،ساعة  16ذه الحقيبة في يتم التدريب على مهارات ه

 ساعات تدريبية 4 الفوتوشوبمدخل إلى  :1الوحدة 

 ساعات تدريبية 4 الطبقات والمؤثرات :2الوحدة 

 ساعات تدريبية 4 مدخل إلى الإليستريتور :3الوحدة 

 ساعات تدريبية 4 الأشكال والرسومات :4الوحدة 

 للحقيبة:الأهداف التفصيلية 

 يلي:ما  المتدربتقن ي التدريبية أنمن المتوقع في نهاية هذه الحقيبة 

 يتعرف على برنامجي الفوتوشوب والإليستريتور والفرق بينهما. .1

 يتعرف على واجهة برنامج الفوتوشوب. .2

 يستخدم أدوات البرنامج. .3

 يتعامل مع طبقات البرنامج. .4

 يطبق المؤثرات. .5

 يحفظ الصور بصيغ مختلفة ويجهزها للطباعة. .6

 يتعرف على واجهة برنامج الإليستريتور. .7
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 مج.يستخدم أدوات البرنا .8

 يخطط العمل على الورق قبل تنفيذه. .9

 يرسم الاشكال والشعارات. .10

 يتعامل مع طبقات البرنامج. .11

 يطبق المؤثرات. .12

 يحفظ الصور بصيغ مختلفة ويجهزها للطباعة. .13
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 مدخل إلى الفوتوشوب

 :Adobe Photoshop CCتحرير الصور ) الفوتوشوب( عن برنامج معالج أو  مقدمة

الدة في  أدوات فعّ (Adobe Photoshop CC سدي دوبدي فوتوشدوب سدي    برندامج )أ يدوفر   

مجال معالجة الصور للمصورين المحترفين  كتصحيح الألدوان والتبداين ومعالجدة وضدوص الصدورة       

وإضافة العديد من التأثيرات بمرونة فائقة لإنتاج صور عالية الجودة  وذلك لاستخدمها في مجدال  

 نترنت.  لعرضها في الإ أوالطباعة والنشر 

 واجهة البرنامج:

( Adobe Photoshop CCسدي  دوبي فوتوشدوب سدي   برنامج )أتحتوي منطقة العمل في 

امددر في أعلددى الشاشددة والعديددد مددن الأدوات وألددواص العمددل المخصصددة للتحريددر         وعلددى قددوائم الأ 

 والتي يوضحها الشكل التالي: وإضافة العناصر إلى الصورة

 
 فوتوشوبوالألواص في منطقة العمل لبرنامج  القوائم والأدواتتوزيع 

 

  

 قائمة الأوامر

 ألواح العمل

 صندوق الأدوات
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 امر:وقوائم الأ

رئيسددة  قددوائم ( تسددعAdobe Photoshop CCسددي دوبددي فوتوشددوب سددي  )أيضددم برنددامج  

 كالتالي :

 

 :File ملف قائمةأولًا: 

وتصدددير الملفددات  بفددتح واسددتيراد   Fileملددف تخددتق قائمددة  

 حفظها بعدة صيغ .و

 

 

 

 

 

 

 

 

 :Edit تحرير قائمةثانياً: 

 ،بنسدددل الصدددور والأشدددكال Editتخدددتق قائمدددة التحريدددر 

 لصقها واستدارتها. ،قصها
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 :Image الصورة قائمةثالثاً: 

بتعددددديل التبدددداين في   Imageتخددددتق قائمددددة الصددددورة  

 تصحيح الألوان والتحكم في الحجم.مثل  الصورة

 

 

 

 

 

 

 

 

 :Layerالطبقات قائمة رابعاً: 

بتعددددديل  الطبقددددات   Layer تخددددتق قائمددددة الطبقددددات  

 وترتيبها
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 :Typeالنوع  قائمةخامساً: 

بندددددوع وأشدددددكال الخطدددددو     Type الندددددوعتخدددددتق قائمدددددة  

 .والنصوص

 

 

 

 

 

 

 

 

 

 

 :Select التحديد قائمةسادساً: 

 أوباختيار نوع تحديد الصورة   Select تختق قائمة التحديد

 والتعديل عليه.، حفظه ،الشكل
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  : Filterالمرشحات  قائمة: سابعاً

بتطبيددق مجموعددة  Filter تخددتق قائمددة المرشددحات

 واسعة من المرشحات على الصورة .

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 :3D قائمةثامناً: 

  .الأبعاد بإنشاء وتصدير صور ثلاثية 3Dتختق قائمة 
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 :View العرض قائمة: ثامناً

بعدرض الأدوات المسداعدة علدى     View تختق قائمة العرض

 الصورة مثل خطو  الأدلة ومسطرة القياس.معالجة 

 

 

 

 

 

 

 

 

 

 :Windows النوافذ قائمة: تاسعاً

بعددرض  وإخفدداء ألددواص    Windows تخددتق قائمددة النوافددذ  

   العمل من مساحة العمل.
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 :Help التعليمات أو المساعدة قائمة: عاشراً

بتقددديم المسدداعدة   Help تخددتق قائمددة التعليمددات 

 في كيفية التعامل مع البرنامج.  

 

 

 فتح ملف :

( هندا  عددة   Adobe Photoshop CCفوتوشوب سي سي دوبي )أبرنامج لفتح ملف في 

 منها:ق طر

  عن طريق القائمةFile  باختيار الأمرOpen  

 عن طريق النقر المزدوج  للفأرة في المساحة الخالية من منطقة العمل أو 

  استخدام اختصار لوحة المفاتيح  أوCTRL + O  

 صندوق الأدوات:

صددندوق الأدوات هددو اللددوص الممتددد عددبر الجانددب الأيسددر مددن منطقددة العمددل ويتضددمن أدوات     

 العرض. واتأدو مامي والخلفيمربعي انتقاء الألوان الأ ،ت الرسم والتحرير واأد ،التحديد 

مدن    Windows>Toolsيمكن إظهار وإخفاء صندوق الأدوات عبر اختيدار الأمدر   كما 

 ، وفيما يلي نستعرض الأدوات بالتفصيل:القائمة
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 : Selection toolالأساسية   الاختيارأداة 

حاطة الجزء المختار بنقا  متحركة وتضم مجموعة من خيارات إوتقوم ب

وتحديد  ،منها على سبيل المثال خيار التحديد على شكل متوازي أضلاع الاختيار

 مود واحد.اع أوتحديد سطر واحد  أو أسطوانيعلى شكل 

 

  :  Move Toolأداة النقل  

صورة أخرى. أي  أوالجزء المحدد منها إلى منطقة  أوتقوم بنقل الصورة 

 جزء منها إلى صورة أخرى مختلفة. أويمكن نقل صورة 
 

 :  Lasso Tool  لحبلأداة ا

 لحبلالمضلع وا بلالقياسي ، الح بلتقدم  ثلاثة أنما  مختلفة: الح

 ستخدم كل منها لتحديد منطقة معينة من الرسم.يو المغناطيسي
 

 :  Magic Toolأداة العصا السحرية  

تحدد العصا السحرية منطقة من الصورة بالاعتماد على تدرجها اللوني 

 أولشمول تحديد أكثر   Toleranceفي التدرج  الاختلافويمكن تعديل درجة 

 أقل.

 

 : Crop Tool  الاجتزاءأداة 

تعمل على تحديد جزء على شكل متوازي أضلاع ومن ثم عند النقر المزدوج 

 تختصر الصورة على هذا الجزء فقط. ،داخل هذا التحديد
 

 : Healing Toolأداة المعالجة  

الوجه. هذه الأداة تختلف عن أداة الختم   تستخدم بشكل رئيسي لرتوش

Stamp Tool   في أنها تعمل على مراعاة النسيج والملمس عند نسل منطقة من

 الصورة إلى منطقة أخرى وبحيث تذوب المنطقة المنسوخة فيما حولها.

 

 : Brush Tool والقلمأداة فرشاة التلوين 

 أومع الحواف الصلبة  اوٍالتلوين لتطبيق اللون بعرض متستستخدم فرشاة 

 .الناعمة ويتغير تطبيق اللون بشكل كبير حسب الخيارات التي تحددها
 

 : Pen Tool القلمداة أ

  .للرسم الحر تعطيك مجالًا
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 : Stamp Toolأداة الختم 

  تقوم بنسل البكسلات من جزء  في الصورة إلى جزء آخر.

 أداة الممحاة : 

تحول البكسلات إلى بكسلات شفافة بشكل  أوتطبق الممحاة خلفية لونية 

 .مفيدة لصقل حواف الصورة يكامل وه
 

 :  Gradient Toolوالتعبئةأداة التدرج 

من الأمام إلى الخلف ضمن حدود المنطقة  اًلوني اًتنشئ أداة التدرج تلاشي

 في الصورة بأكملها وتتضمن خمسة أشكال . أوالمحددة 
 

 : Blur Toolأداة التمويه 

: تمويه ، توضيح ، تبقيع ، تسمح بالتأثير بشكل  ةهذه الخيارات الثلاث

 على منطقة محددة من الصورة . انتقائي
 

 : Dodge Toolأداة إنقاص الكثافة 

خيارات : إنقاص الكثافة ، زيادة الكثافة ،  ةتعطي هذه الأداة ثلاث

 .التبهيت
 

 أداة النق: 

  وتنسيقها من لوص الخيارات. وتستخدم لكتابة النصوص على الصورة

 :  Path Selection Tool أداة اختيار المسار

  لاختيار مسار تحديد الأشكال.

 أداة التكبير والتصغير: 

يتم تصغير   Optionعند الضغط على مفتاص و وتستخدم لتكبير الصورة

 الصورة.
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 اختصارات لوحة المفاتيح:

CTRL +O     لفتح الملف 

CTRL +N    عمل ملف جديد 

CTRL + S     لحفظ الملف 

CTRL + Shift + S لحفظ الملف باسم جديد 

Option +  CTRL + Shift + S    حفظ الملف لاستخدامات الويب 

CTRL + C    لنسل الشكل 

CTRL + X    لقق الشكل 

CTRL + V    للصق الشكل 

CTRL + Z    للتراجع خطوة واحدة 

Option +  CTRL + Z    للتراجع عن عدة خطوات سابقة 

CTRL + A    تحديد كامل الصورة 

CTRL + D    لإلغاء التحديد 

Shift +  CTRL + I    التحديد عكس 

CTRL + U  فتح نافذة( لتعديل ألوان الصورةHue/Saturation) 

Shift +  CTRL + U    لتحويل الصورة إلى أبيض وأسود 

CTRL + L      لتعديل درجات الصورة )فتح نافذة(Level 

 CTRL + J       لعمل نسل للطبقة المحددة 

CTRL +E       لدمج الطبقات 

CTRL +B        الألوان ميزانلإظهار 

CTRL +P    لطباعة الصور 

CTRL +R      لإظهار وإخفاء المساطر 

CTRL + W    لإغلاق الصورة 

CTRL + Q    لإغلاق البرنامج 

لاختصددار وقددت العمددل وسددرعة  الفوتوشددوبتسددتخدم اختصددارات لوحددة المفدداتيح  في برنددامج 

أكثدر الاختصدارات   ، والوقت في التنقل بين القدوائم وألدواص العمدل بالفدأرة     ضياع من الإنجاز بدلًا

 هي: استخداماً
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 لتراجع عن الخطوات:ا 

تطبيددق الأعمددال الددتي أديتهددا  بحيددث يمكنددك   بددالتراجع وإلغدداء الفوتوشددوبيسددمح برنددامج 

وينددرج  ، يعدني التراجدع     Undoوكمدا هدو معدروف في أغلدب الدبرامج فدإن أمدر       ، خيارات أخدرى 

ويعددني التراجددع لخطددوة واحدددة فقددط للخلددف ويمكددن        Editهددذا الأمددر تحددت قائمددة التحريددر     

 لعمل ذلك.   CTRL +Zاستخدام مفتاص  

اجع عن عدة خطوات عن طريق اختيدار أي خطدوة سدابقة    كما يوفر البرنامج إمكانية التر

 + CTRL           بالضغط المتكرر على مفتداص   أو History السيرة أو التاريل من لوص العمل

Shift + Z .لتصل للخطوة السابقة المناسبة 

 
 Undo أمر التراجع

 
 History لوص العمل

 .  Windows>Historyكن إظهار لوص العمل باختيار الأمر يم
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 :)التحديد(  عمليات الانتقاء

 الانتقاء: كيفية

إن تعلم كيفية انتقاء  وتحديد منطقة معينة من الصورة يعتبر من المهارات المهمة ويجدب أن  

 ذعندئدد ،عددد أن تقددوم بإنشدداء عمليددة التحديددد  ، وذلددك بالتددأثير عليدده  دتقددوم أولا بتحديددد مددا تريدد 

المناطق الواقعة خارج نطداق  أما يمكن تحرير وتغيير المنطقة الواقعة ضمن عملية التحديد فقط. 

 ستكون محمية ولن تتأثر بالتغييرات التي تجريها على الصورة.فالتحديد 

 :استخدام أدوات الانتقاء على صور مختلفة
 

 التحديد أدوات

 مستطيلة أشكال على هيئة تحديدات عمل تمكنك من 

 .مفردة وأعمدة مفردة بيضاوية، وصفوف وأشكال

 

 الحبل أداة 

 يدوية مسارات على هيئة تحديدات عمل من تمكنك 

  منجذبة إلى ومغناطيسية الحواف مستقيمة مضلعة وأشكال

 .الحبل
 

  التحريك أداة

 .والأدلة والطبقات التحديدات تحريك من تمكنك

 

  السريع التحديد أداة

 رأس أنسب مستخدمًا بسرعة التحديد طلاء من تمكنك

 .دائرية فرشاة
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  السحرية العصا أداة

 .متشابهة بألوان الملونة تحديد المساحات من تمكنك

 

  الحصد أداة

 .الصور قطعتقوم ب

 

  الشرائح تحديد أداة

 .الشرائح بتحديد تقوم

 

 التركيز معالجة فرشاة أداة

 .الشوائب والكائنات تزيل 

 

  الإصلاح أداة

 الصورة في محددة في مساحة العيوب بإصلاص تقوم

 .أوحوش عينة باستخدام

 

 المعالجة فرشاة أداة

في  العيوب لإصلاص حشو أو عينة بالطلاء باستخدام تقوم 

 .الصورة
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 الحمراء العين أداة

 فاشل وميض من اللون الأحمر الناتج انعكاس تزيل 

 .الكاميرا

 

 

  الاستنساخ ختم أداة

 .صورة من عينة بالطلاء باستخدام تقوم

 

 الممحاة أداة

 إلى الصورة من باستعادة أجزاء وتقوم البيكسل تزيل 

 .المحفوظة مسبقًا صيغتها

 

  السحرية الممحاة أداة

 طريق عن الشفافية إلى المصمتة ذات الألوان المساحات تزيل

 .نقرة واحدة

 

 النموذج ختم أداة

 

 .كنموذج صورة من باستخدام جزء بالطلاء تقوم
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 الخلفية ممحاة أداة

 .السحب طريق عن إلى الشفافية مساحات تزيل 

 
 

 التمويه أداة

 .في الصورة الحادة الحواف بتمويه تقوم 

 

 التوضيح أداة

 .الصورة في الحواف الباهتة وضوص بزيادة تقوم 

 

 الإصبع أداة

 .الصورةفي  البيانات بطمس تقوم 

 

 اللون كثافة إنقاص أداة

 .الصورة في ساحاتإضاءة الم من تزيد 

 

 اللون كثافة زيادة ةأدا

 .الصورة في عتمة المساحات من تزيد 
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  فنجةالإس أداة

 .في مساحة اللون تشبع من تزيد

 

 الفرشاة أداة

 .شكل الفرشاة حدود برسم تقوم 

 

 الرصاص القلم أداة

 .الحواف حادة حدود شكل برسم تقوم 

 

 اللون استبدال أداة

 .جديد أخر المحدد بألوان  اللون تستبدل 

 

 المحفوظات فرشاة أداة

الصورة  نافذة إلى لقطة أو المحددة من الحالة نسخة ترسم 

 .الحالية

 

 الفنية المحفوظات فرشاة أداة

 يحاكي أنما  نمط ذات شكل حدود ترسم باستخدام 

 .المحددة اللقطة أو باستخدام الحالة المختلفة الأخرى الرسم
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 اللوني التدرج أداة

 واتجاه مستقيم خط هيئة الألوان على بني مزج تنشئ 

 .ومعني وزاوية ومنعكس قطري
 

 

 الطلاء دلو أداة

 لون باستخدام المتشابهة ذات الألوان المساحات بتعبئة تقوم 

 .الواجهة الأمامية

 

 المسار تحديد أداة

 نقا  إظهار مع التحديدات أوتجزئة شكل بعمل تقوم 

 .الاتجاه ونقا  الاتجاه الإرساء وخطو 

 

 الكتابة قناع أداة

 .الكتابة لعلى شك تحديد بإنشاء تقوم 

 

 الخط وأداة الشكل أداة

 طبقة أو العادية الطبقة في أشكالًا وخطوطاً ترسم 

 .الشكل

 

 الكتابة أداة

 .على الصورة كتابة بإنشاء تقوم 
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 الريشة أداة

 .ناعمة ذات حواف مسارات رسم من تمكنك 

 

 المخصص الشكل أداة

 قائمة من اختيارها يتم أشكال مخصصة بإنشاء تقوم 

 .أشكال مخصصة

 

 الشاطفة أداة

 .في الصورة الألوان من عينات تأخذ 

 

 اليد أداة

 .بها النافذة الخاصة نطاق داخل الصورة تحر  

 

 المسطرة أداة

 .والمواقع والزوايا المسافات تقيس 

 

 التحجيم أداة

 .الصورة عرض وتصغر تكبير 

 



 لمناهجلالإدارة العامة   التصميم بالفوتوشوب والإليستريتور

 

 

24 

 التدوير أداة

 .العمل حقل تدير 

 

 :التصميم الرسومي

 دائرة الألوان:

بالذهن  والمقصود بها ترتيب الألوان في صورة تعلق،  هي وسيلة علمية لدراسة الألوان

وعلاقتها  فيالأماكن الواجب أن تشغلها ، بحيث تتفق مع تسلسل ألوان الطبوضع الألوان في 

 .والتباين في ما بينها من حيث التكامل

 

http://www.gl3a.com/vb/redirector.php?url=http://arabsh.com
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 (:الرئيسية) الألوان الأساسية

 
 

والأزرق( وسميت بالأساسية لأننا بمزجها نستطيع تكوين  وهي ثلاثة ألوان )الأصفر والأحمر

 .الإنسان اللونية الأخرى التي عرفهاوالدرجات  أو صنع كل الألوان الفرعية

 :الثانوية الألوان

 
 :الثانوية الألوان

 

 :هي أنواعالثانوية ثلاثة  اللون الثانوي هو اللون الناتج عن مزج لونين أساسيين ، والألوان

 .والأحمر البرتقالي: وينتج بمزج اللونين الأصفر -

 .والأزرق البنفسجي: نحصل عليه بمزج الأحمر -

 .والأزرق الأخضر: وهو ناتج مزج الأصفر -

 

http://www.gl3a.com/vb/redirector.php?url=http://arabsh.com
http://www.gl3a.com/vb/redirector.php?url=http://arabsh.com
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 :الباردة والألوان الألوان الدافئة

 
 

 : الألوان الحارة أو الدافئة

تشعرنا بالدفء والحرارة حين  وهي ألوان ،هي الألوان المشتقة من ألوان الشمس والنار والدم 

 الحارة النظر إليها ولهذا سميت بالألوان الدافئة أو

وبالتحديد ، ممكن أن نقول بأن الألوان   رالأصفالألوان الدافئة هي : الأحمر ، البرتقالي ، 

 . التي نراها عادةً في النار الدافئة هي الألوان

 . لتوصيل الغضب ، الكره ، الحقد الألوان الدافئة تستخدم عادةً لإظهار الابتهاج. أو تستعمل

 . بنفسجي تعتبر ألوان باردةالأخضر، الأزرق، ال :الباردة الألوان

نراها عادةً في الطبيعة )الماء  وبالتحديد ، يمكننا القول بأن الألوان الباردة هي الألوان التي

 .والهدوء والانشراص ،والسماء والنباتات ( وهي ألوان تشعرنا بالبرودة

تستعمل   ةالنشاطات الهادئ الألوان الباردة تستعمل عادةً لإظهار الهدوء ، والتعبير عن

على الجدران ، وذلك لإبقاء  المستشفيات اللون الأزرق المخضر ، مدموجان مع بعضهما البعض

 .المرضى بأعلى درجة من الهدوء والراحة النفسية

 

http://www.gl3a.com/vb/redirector.php?url=http://arabsh.com
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 ن:اللو

جميعنا نعلم  ،نتيجة لوقوع الضوء عليها المجردةالتي تبدو للعين  هو صفه أو مظهر للسطوص

البرتقالي،  ، الأحمر : وهي فيالط ألوان عند ذكرها أذهاننا إلىفأول ما يتبادر  الألوان ماهي

 .البنفسجي النيلي، ، الأزرق ، الأخضر ، الأصفر

 : تنقسم الألوان إلى

 .حدة وسنفصل كل منها على،  حارة   -باردة - متكاملة- محايدة- ثانوية -  أساسية

 :الأساسية هي

بل توجد في  أخرى ألوانيمكن تكوينها من دمج  الألوان ولامنه كل  الأساس الذي تتكون

 : وهي الأصلي ويمكن هذا سبب تسميتها بالألوان الأساسية الطبيعة على شكلها

 

 

 :قاعدة

 .الرمادي ناتج خلط الألوان الأساسية بنسب متساوية يعطي اللون

 :الثانوية الألوان

 :على النحو التالي تتفرع من دمج الألوان الأساسية لأنهاوسميت ثانوية أو فرعية 

http://www.gl3a.com/vb/redirector.php?url=http://up.arab-x.com/
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 التعرف على أنظمة الألوان:

 

هو النظام الذي يتم من خلاله تطبيق الألوان وتمثيلها، ويسمى  (Color Mode)نظام الألوان 

 نظام الألوان أيضاً وضع الألوان أو نموذج الألوان.

يتم خلطها لإنشاء الألوان المستخدمة في الصورة ويحدد نموذج اللون الألوان الأساسية التي  

 ونماذج الألوان المتوفرة في فوتوشوب هي:

 :RGBنظام  -1

وهذه  Blueوالأزرق  Greenوالأخضر  Redهذه الحروف ترمز إلى الألوان الأحمر  

 الألوان الثلاثة : هي التي يتم استخدامها لإنشاء بقية الألوان في الصورة.

 :CMYKنظام  -2

http://www.gl3a.com/vb/redirector.php?url=http://up.arab-x.com/
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الأحمر  (Magenta))الأزرق(، والماجنتا  Cyanهذه الحروف ترمز إلى الألوان السيان 

 .(Black)والأسود  (Yellow)الأرجواني، والأصفر 

 ويتم تمثيل الألوان بتحديد نسبة مئوية من كل هذه الألوان الأربعة وعلى سبيل المثال اللون 

 .%0والأسود  %97والأصفر  %99والماجنتا  %1الأزرق 

 :Grayscale)نظام التدرج الرمادي ) -3

درجة من درجات الرمادي وفي صورة تدرج الرمادي يمكن أن يحتوي كل  256هنا   

)اللون الأبيض( وأي درجة  255بكسل على قيمة سطوع تتراوص بين صفر )اللون الأسود( و

 بين هاتين الدرجتين هي درجة من درجات الرمادي.

 :(Bitmap)نظام الصورة النقطية  -4

الصورة ذات التدرج الرمادي عند تحويلها إلى هذا النظام سيتم تخفيض الألوان إلى لونين  

 الأسود والأبيض. مافقط ه

 :Doutoneنظام الألوان الثنائية  -5

الصورة إلى لونين أو ثلاثة،أو أربعة  كما يتضح من اسمه فإن هذا النظام يقلل الألوان في 

 ألوان باستخدام أحبار خاصة.

 :فهم الألوان وتصحيحها في الصورة

، ستظهر لك قائمة تحتوي على نظم الألوان  Mode، ثم اختر أمر  Imageافتح قائمة  

 المتاحة.
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قناة لكل لون في الصورة بحسب نظام الألوان الذي  Channelsتعرض لوحة الأقنية 

 تحتوي على خمسة أقنية:فإن لوحة الأقنية  (CMYK)اخترته وعلى سبيل المثال نظام 

 وقناة لكل لون من الألوان الأربعة السيان والماجنتا والأصفر والأسود. ،القناة المركبة

 
 يير الألوان / تغيير أو إنتاج الدرجات الظليةتغ
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يوصف إنتاج الدرجة الظلية بالعلاقة بين كثافة الأصل والنسبة المئوية لمساحة النقطة 

وتشمل مناطق إنتاج الدرجة الظلية أساساً ثلاث مناطق هي: مناطق  ،الشبكية للإنتاج 

 الإضاءة العالية والظلال المتوسطة والظلال.

استخدام صندوق حوار وتتم تأدية إنتاج الدرجة الظلية في برنامج أدوبي فوتوشوب ب

المنحنيات لكل ألوان الطباعة السيان والماجنتا والأصفر والأسود باختيار قناة اللون والتحكم 

  فيها حسب الدرجة اللونية المطلوبة.

 

والذي يمكنك أن تعرضه بفتح  (Curves)ويمكنك استخدام مربع حوار المنحنيات  

ويمكنك استخدام هذا المربع  Curvesثم  Adjustmentsثم اختيار أمر  Imageقائمة 

 لضبط نظام الألوان في الصورة بأكملها.

ولتعديل نطاق الألوان وتوازن اللون، ضع مؤشر الفأرة فوق أي نقطة على الخط المنحني ثم  

اسحب إلى أعلى أو أسفل أو اليمين أو اليسار ثم راقب تأثير ذلك على الصورة. وإذا أردت إجراء 

ويات لونية معينة في الصورة فقط وليس على جميع الألوان فيها افتح قائمة تعديلات على مست

(Channel) .الموجودة في أعلى مربع الحوار ثم اختر القناة اللونية التي تريد تعديلها 

 : (Levels)ضبط مستويات الألوان 

ضبط المناطق  Image > adjustments > levelsعن طريق  Levelsيتيح لك أمر  

 المضيئة والظلال في الصورة.

 ويتم ذلك بسحب ثلاث أدوات انزلاق لتعديل المستويات المختلفة في الصورة. 
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 التحكم في مناطق الإضاءة والتباين:

إذا أردت مزيداً من التحكم في إضاءة أو تباين الألوان في الصورة استخدم أمر  

(Brightness and Contrasts) ،  ويمكنك أن تجد هذا الأمر أسفل قائمة

(Adjustment)  أسفل قائمة(Image)  سيظهر لك مربع الحوار وهو يحتوي على أداتي

 انزلاق واحدة لتعديل الإضاءة والأخرى لضبط التباين.
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 والمؤثرات الطبقات

 :لوحة الطبقات

أعلى اللوحة، تقوم لوحة الطبقات بعرض الطبقات مع جعل الطبقة الأمامية تظهر في 

ويمكنك استخدم اللوحة لإنشاء وحذف طبقات وإخفائهم وإقفالهم ودمجهم وتحديد الخيارات 

التي تحدد كيفية إظهار وطباعة الطبقات، كما يمكنك تغيير ترتيب تتابع الطبقات ونقل 

 الكائنات من طبقة لأخرى.

لطبقة لا تحتوي تخيل الطبقات كورقة شفافة متتابعة فوق بعضها البعض؛ إذا كانت ا

 على أي كائنات، فإنه يمكنك رؤية أي كائنات واقعة على طبقات خلفها من خلالها.

 

 

 وثيقة والطبقات الخاصة بها

إذا  تحتوي الطبقات على كل صفحات الوثيقة متضمنةً الصفحات الأساسية، على سبيل المثال

مخفية على  تبقىالطبقة  في وثيقتك فإن 1أثناء قيامك بتحرير صفحة  1قمت بإخفاء طبقة 

 كل الصفحات إلى أن تقرر إظهارها مرة أخرى.
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 لوحة الطبقات

 .إظهار/إخفاء )حالياً مرئي( -1

 .طبقة مخفية )أيقونة العين مخفية( -2

 إضافة طبقة قناع. -3

 تعديل على خصائق الطبقة. -4

 إنشاء مجموعة جديدة. -5

 إنشاء طبقة جديدة. -6

 سلة المحذوفات. -7

 حالياً.الطبقة المستهدفة  -8

 .إقفال/فك إقفال )حالياً مقفل( -9

 :إضافة كائنات إلى الطبقات

أي كائن جديد يتم وضعه على الطبقة المستهدفة والتي يتم عرض أيقونة القلم بجوارها 

في لوحة الطبقات، حيث أن استهداف طبقة يؤدي إلى تحديدها أيضاً، وفي حالة ما إذا تم 

دة منهم لا يغير التحديد ولكن استهداف طبقة تحديد أكثر من طبقة فإن استهداف واح

 خارج نطاق الطبقات المحددة يلغي تحديد الطبقات الأخرى.
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 يمكنك إضافة كائنات للطبقة المستهدفة بأي من الطرق التالية:

 .إنشاء كائنات جديدة باستخدام أداة الكتابة أو أدوات الرسم 

 .إدراج أو تضمين أو لصق نق أو رسومات 

  الكائنات على طبقات أخرى ثم نقلهم لطبقة جديدةتحديد. 

 ملاحظة: 

لا يمكنك رسم أو إدراج ملف على طبقة مخفية أو مقفلة، وعندما تختار أداة رسم أو أداة 

كتابة أو إدراج ملف وتكون الطبقة المستهدفة مخفية أو مقفلة فإن المؤشر يتغير إلى أيقونة 

على شاشة الوثيقة؛ قم بإظهار أو عدم إقفال الطبقة قلم رصاص مشطوب  عندما يتم توجيهها 

لصق عندما تكون  <المستهدفة أو استهداف طبقة مرئية وغير مقفلة، وإذا اخترت تحرير 

الطبقة المستهدفة مخفية أو مقفولة، فإن رسالة تحذيرية تخير  بين إظهار أو عدم إقفال 

 الطبقة المستهدفة.

 طبقاتتحديد ونقل ونسل الكائنات على ال

في لوحة الطبقات، فإنه  يمكنك تحديد أي كائن على أي طبقةفي الوضع الافتراضي، 

يساعد  لون تحديد  ،يتم استخدام النقا  لإبراز الطبقات التي تحتوي على كائنات محددة

 الطبقة على تعريف طبقة الكائن، ولمنع تحديد كائنات على طبقة معينة، قم بإقفال الطبقة.

 ائنات على طبقة معينة:لتحديد كل الك

)في حالة نظام  Option( أو Windows)في حالة نظام التشغيل  Altاضغط على مفتاص 

 ( أثناء نقر طبقة في لوحة الطبقات.Mac OSالتشغيل 

 لنقل أو نسل كائنات إلى طبقة أخرى:

  باستخدام أداة التحديد، حدد واحد أو أكثر من الكائنات على صفحة وثيقة أو

 أساسية.صفحة 

 :في لوحة الطبقات، نفذ إحدى الخطوات التالية 

o  لنقل كائنات محددة إلى طبقة أخرى، قم بسحب النقطة الملونة الواقعة على

 .الجانب الأيمن لقائمة الطبقات إلى الطبقة الأخرى
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o  لنقل الكائنات المحددة إلى طبقة مخفية أو مقفلة، اضغط مفتاصCtrl  في(

)في حالة نظام التشغيل  Command( أو Windowsحالة نظام التشغيل 

Mac OS.عندما تقوم بسحب النقطة الملونة ) 

o  لنسل كائنات محددة لطبقة أخرى، اضغط مفتاصAlt  في حالة نظام التشغيل(

Windows أو )Option  في حالة نظام التشغيل(Mac OS عندما تقوم )

قائمة الطبقات إلى الطبقة بسحب النقطة الملونة الواقعة على الجانب الأيمن ل

 .الأخرى

o  لنسل الكائنات المحددة إلى طبقة مخفية أو مقفلة، اضغط مفتاحي

Ctrl+Alt  في حالة نظام التشغيل(Windows أو )Command+Option 

 ( عندما تقوم بسحب النقطة الملونة.Mac OS)في حالة نظام التشغيل 

 تغيير ترتيب الطبقات:

يغير من ترتيب الطبقات على كل صفحة وليس فقط على حيز ن إعادة ترتيب الطبقات إ

 الصفحات المستهدف.

في لوحة الطبقات، قم بسحب طبقة لأعلى أو لأسفل في القائمة، كما يمكنك أيضاً 

 سحب طبقات متعددة محددة.

  

 إعادة ترتيب الطبقات
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 : المؤثرات

تأثيرات مختلفة على الصور هي عبارة عن برامج صغيرة تضاف لبرنامج الفوتوشوب لعمل 

 بخطوات بسيطة.

برنامج الفوتوشوب على جهاز الحاسب يتم إنشاء مجلد خاص من ضمن  تنصيبعد ب

وتظهر بواجهة  Plug-Ins folder يسمى  ملفات البرنامج يضم هذه الإضافات والفلاتر

 الافتراضيةالتى تضم العديد من التأثيرات  "Filter البرنامج من ضمن أشرطة القوائم "قائمة

 .مع البرنامج

 

 :المؤثراتأنواع 

الموجودة ببرنامج الفوتوشوب ، تحتوى هذه  الافتراضيةوالإضافات  المؤثرات -1

على العديد من التأثيرات الفنية التى بالإمكان تطبيقها على الصور  المؤثرات

م أو الفرشاة وتأثيرات مختلفة كالمرسومة بالقل  ،لتعطى لها مظهر مختلف مثلًا

 .للإضاءة ودرجة وضوص الصورة وغيرها

 Filter Gallery أو المؤثراتمعرض  Filter ويوفر أيضًا البرنامج بقائمة

على الصورة ومعاينتها والتعديل على الإعدادات  المؤثر اختبارتستطيع من خلاله 

 .للحصول على أفضل نتيجة

 المؤثراتيتم تحميلها وتركيبها لبرنامج الفوتوشوب ، ويمكن تحميل  مؤثرات -2

 عن طريق الذهاب إلى قائمة Adobe الإضافية من المواقع مثل موقع أدوب
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Filter  ثم إختيار Browse Filter online  والمؤثراتوتصفح اللإضافات . 

مناسب  المؤثرأو تحميل هذه الإضافات من مواقع موثوق بها ولكن تأكد أن 

 .م التشغيلالإصدار البرنامج الذى تعمل به ونظ

نوع آخر   أو تنصيبهإلى نوع أشبه بالبرنامج الصغير يتم  المؤثراتوتنقسم هذه 

 .تنصيبهلايتم 

 للبرنامج: إضافة المؤثراتكيفية 

من النوع الذى يستدعى  رالمؤث، إذا كان  استخدامهالذى تريد  المؤثربعد تحميل   -1

مثل أى برنامج ثم أعد تشغيل برنامج  التنصيبقم بإتباع خطوات  تنصيب

 .بالبرنامج Filter الجديد من ضمن قائمة المؤثرسوف تجد  ، الفوتوشوب

 المؤثراتفقم بنسخه إلى مجلد  تنصيبهيتم  من النوع الذى لا المؤثرأما إذا كان  -2

 :يلتالكاكون مساره على جهاز الكمبيوتر الخاص ببرنامج الفوتوشوب وي

ins-Plug\Adobe Photoshop CS6\Adobe\Program Files\C: 
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 المؤثرات:تطبيقات على 

 

 الصورة الأصل

 

Filter > Blur > Motion Blur 

 
 الصورة الأصل

 
Filter > Distort > Twirl 

 
 النق الأصل

 
Filter > Pixelate > Fragment 
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 جديدةقم بفتح عمل جديد ثم إنشاء طبقة 

وقم بتغيير لون الواجهة ولون الخلفية كما في 

  الشكل

Filter > Render > Clouds 

 

 الصورة الأصل مع تحديد جزء منها

 

Filter > Stylize > Find Edges 
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 مدخل إلى الإليستريتور

 :(الإليستريتورالرسومات )عن برنامج تصميم  مقدمة

ف برندددامج وهدددو بخدددلا ،  روع بدددرامج الرسدددم أو اقدددوىبرندددامج الأدوبدددي إليسدددتريتور    يعتدددبر

هددذا  ويمكننددا اسددتخدام  ، فددى العمددل  أساسدديعلددى الصددور بشددكل  ي يعتمددد الفوتوشددوب الددذ 

ة يدددم الرمدددوز والشدددعارات والرمدددوز النقط  يالمختلفدددة مثدددل تصدددم   التصدددميماتعمدددل في البرندددامج 

 . ت والكتبلاغلفة المجأشورات وووالملصقات والبر والإعلاناتوالمطبوعات والمخططات 

 :(Vector Shapes)الأشكال المتجهة 

النقا  مع بعضها وتتصل هذه  Anchor Pointرة عن مجموعة من النقا  تسمى هى عبا

ة يالنها في يلة لتعطية او مستطيمنحن تكون  Paths أوسطة خطو  تسمى مسارات االبعض بو

 ي:ظهر بالشكل التالي كما ينشكل مع

 

حيث داخل الشكل المرسوم  يةاضيت الرلاالخطو  عبارة عن مجموعة من المعاد ههذ

 يرة ولذلك عند تكبنيملف الرسوم المنحمرفقة داخل  رياضيةقوم الحاسب بعمل معادلة يي

 ي:كما فى الشكل التال تشوهدث لها اى لا يحة هالمتج الأشياء
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 :(Raster Images)الصور 

المربعات اللونية الصغيرة بجوار بعضها البعض لتكوين الشكل تتكون من مجموعة من 

 ، كما في الشكل التالي: (Pixel) ويسمى كل مربع بيكسل

 

 واجهة البرنامج:

امدر في أعلدى الشاشدة والعديدد     وعلدى قدوائم الأ  ليستريتور برنامج الإتحتوي منطقة العمل في 

والددتي يوضدددحها   العناصددر إلى الصدددورة مددن الأدوات وألدددواص العمددل المخصصدددة للتحريددر وإضدددافة    

 الشكل التالي:

 

 ليستريتورالإتوزيع الأدوات والخيارات والألواص في منطقة العمل لبرنامج 
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 ملف : إنشاء

و أ File > New يدتم الضدغط علدى قائمدة    أدوبي إليسدتريتور  برنامج لإنشاء ملف جديد في 

 :فتظهر لنا النافذة التالية Create  New مرنختار الأ الترحيبيةمن النافذة 

 
 

 التالي:النافذة على  ذهتحتوى ه 

1- Recent لاختيار ملف لبدء العمل. 

2- Mobile على الأجهزة الذكية. صفحة: لإنشاء 

3- Web.لإنشاء صفحة على الإنترنت : 

4- Print :.لطباعة العمل بمقاسات مختلفة 

5- Film&Video.لإنشاء فلم أو فيديو : 

6- Art&Illustrationبروشور أو بوستر. : لإنشاء 

 

  Createعلدى   انقدر إنشدائها  المطلدوب   الصدفحة صدفات  اار حجدم ومو يد مدن اخت  الانتهداء بعدد  

 .لإنشاء الملف وبدء العمل
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 الأدوات:معارض 

 رسم.ال ومعالجة لإنشاء الأدوات من العديد الإليستريتوريوفر 

 التحديد أدوات معرض 

 ( V )أداة التحديد  

 

 يختار جميع الإشكال

 

أداة التحديد المباشر  

( A ) 
تحديد نقا  أو مقاطع  

 ضمن المسار

 

 أداة التحديد

 

يختار مجموعات 

الكائنات داخل 

  المجموعات
 

 أداة العصا السحرية

  ( Y ) 

 

يحدد الكائنات ذات 

 سمات مشابهه

 

 أداة لوح الرسم

 

لوص الرسم للطباعة أو 

 التصدير

 

 ( Q )أداة لآسو  

 

أو مقاطع يحدد نقا  

 المسار ضمن الكائنات

 

 معرض أدوات الرسم

 

أداة نقطة إضافة 

 ( + )مرساه  

 

تضفي نقطة الإرساء على 

 المسارات
 

 ( P )أداة القلم  

 

يرسم خطو  مستقيمة 

 ومنحنية لإنشاء كائنات
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أداة تحويل نقطة 

 مرساه

( Shift + C ) 

 

تحويل سلس للنقا  إلى 

 زوايا والعكس
 

أداة نقطة حذف مرساه  

( _ ) 
 

لحذف نقا  الربط من 

 المسارات

 

 أداة القوس

 

لعمل منحنيات مقعر هاو 

 محدبه

 

 ( \ )أداة الخط  

 

 لعمل خطو  مستقيمة

 

 أداة الشبكة

 

 تفلت شبكات مستطيلة

 

 أداة لولبية

 

تلف اللولب في اتجاه 

 عقارب الساعة

 

 أداة المستطيل

 

يرسم المربعات 

 والمستطيلات

 

 أداة الشبكة القطبية

 

تفلت شبكات مخطط 

 دائري

 

 أداة البيضاوي

 

يرسم دوائر وإشكال 

 بيضاوية

 

 أداة مستطيل مدور

 

توجه المربعات 

والمستطيلات مع تدوير 

 زواياها
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 أداة المضلع

 

للرسم المتعدد الجوانب 

 والأشكال

 

 أداة النجوم

 

لعمل النجوم بأشكال 

 مختلفة

 

 أداة مضيئة

 

لعمل إضاءات شمسية 

 مضيئة

 

 أداة قلم الرصاص

 

 ة اليدويةفيللتعديلات الطف

 

 أداة التنعيم

 

 لتنعيم المسارات

 

 أداة مستطيل مدور

 

 لمسح النقا  والأشكال

 

 أداة المنظور

 

يقدم عمل فني بوجهات 

 مختلفة

 

 أداة تحديد المنظور

 

يسمح بتحقيق الأهداف 

الاشياء والرموز وتحريك 

في نصابها ونقل الكائنات 

 بشكل عامودي
 

 أداوت منوعةمعرض 

 أداة الكتابة

 

لعمل كتل الكتابة 

 وتحرير النق

 

أداة  التغيرات 

 النصية

 

يتيح لك تشكل النق 

 حسب الشكل
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أداة الكتابة على 

 مسار

 

للكتابة على عدة 

 مسارات وتحريرها

 

أداة الكتابة 

 الرأسية

 

بالكتابة يتيح لك 

الراسية والعمل على 

 تغييرها
 

أداة التغيرات 

 الرأسية

 

يعمل مع التغيرات 

 الراسية ويتيح التغيير

 

 أداة مسار عمودي

 

لتغيير المسارات إلى 

 عمودي ويتيح التغيير بها

 

أداة التغيرات 

 الراسية

 

يعمل مع التغيرات 

 سية ويتيح التغييرالرأ
 

 أداة شبكة

 

تنسجم  إنشاء وتحرير 

 مغلفات شبكه

 

 أداة التدرج

 

تتيح بأخذ عينه من 

اللون داخل الكائنات 

 أو التدرجات اللونية

 

 أداة الطلاء

 

يسمح بجميع أنواع 

 الطلاء مع سماتها
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أداة تحديد الطلاء 

 النشط

 

تحديد أماكن 

 الطلاء النشط

 

 أداة القياس

 

لقياس المسافة بين 

 نقطتين

 

 معرض أدوات التشكيل

 أداة التدوير

 

 التدوير حول نقطه ثابته

 

 أداة العكس

 

تقلب الأشياء لأكثر من 

 محور ثابت

 

 أداة المقياس

 

تغيير حجم الكائنات حول 

 نقطة ثابتة

 

 أداة القص

 

يشوه كائنات حول نقطة 

 ثابتة
 

 أداة إعادة التشكيل

 

يضبط نقا  الربط 

المحددة مع الحفاظ على 

 التفاصيل الشاملة
 

 أداة التحويل الحر

 

 موازن هاو تشويه التحديد

 

 أداة المزج

 

تقوم بإنشاء سلسلة من 

الكائنات ومزج شكلين 

 مختلفين
 

 أداة العرض

 

يسمح بعرض السكتة 

 الدماغية بعرض متغير
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 أداة الاعوجاج

 

لعمل قوالب الكائنات مع 

 حركة المؤشر

 

 أداة البرم

 

لخلق تشوهات مبرومة 

 للكائنات

 

 أداة التجعيد

 

تفريغ كائن عن طريق 

نقا  تحريك نقا  

 التحكم بعيدا عن  المؤشر
 

 أداة لأنفخ

 

يعمل على نفل نقطه بعيدا 

 عن المشر

 

 أداة الاسكالوب

 

يضفي تفاصيل منحنية 

عشوائية الى الخطو  

 العريضة للكائن

 

 أداة التغيرات الراسية

 

يعمل مع التغيرات الراسية 

 ويتيح التغيير

 

 أداة التغيرات الراسية

 

يعمل مع التغيرات الراسية 

 ويتيح التغيير

 

 أداة بناء الشكل

 

يدمج الأشكال البسيطة 

لخلق العرف والأشكال 

 المعقدة

 

 معرض الأدوات الرمزية

 أداة  البخاخ

 

يضع حالات متعددة 

 كمجموعة رسم

 

 أداة شفيتر

 

لتتغير الحالات وتغيير 

 تراصها
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 التقاربأداة 

 

يقوم بتحريك الحالات 

 بالتقارب

 

 أداة تحجيم

 

 يعمل تغيير حجم الحالات

 

 أداة سبينر

 

 تقوم بتدوير الأشكال

 

 أداة الدهان

 

يقوم بدهن الأشكال 

 بتدرجات مختلفة

 

 أداة الفرز

 

 يطبق على الحالات غموض

 

 أداة الطراز

 

يطبق النمط المحدد لحالات 

 الطراز

 

 الرسم البيانيمعرض أدوات 

أداة الرسم البياني 

 العمودي

لعمل الرسم البياني 

 باستخدام أعمده رأسية

 

أداة رسم بياني لعمود 

 مكدس

لعمل أعمده بيانيه فوق 

 بعضها البعض

 

 أداة رسم بياني أفقي

لعمل الرسم البياني الأفقي 

 على هيئة أعمدة أفقية

 

 أداة بياني مكدس أفقي

بعضها لعمل الأعمدة فوق 

 بشكل افقي
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 أداة خط الرسم البياني

تستخدم نقا  لتمثل واحده 

أو أكثر من مجموعة من 

القيم بخط مختلف بالوان 

 مختلفة

 

أداة رسم بياني منقطة 

 مؤكده

 يعمل رسوم بيانيه مؤكده

 

 أداة رسم بياني مبعثر

لعمل رسومات بيانيه 

للإحداثيات على طول 

محاور الرسم المبعثر وهي 

مفيدة لتحديد الأنما  في 

البيانات وتشير لتأثر 

 البيانات
 

أداة الرسم البياني 

 فطيره

يخلق الرسوم البيانية 

الدائرية تمثل لأنسب المئوية 

 للقيم

 

 أداة التكبير

يزيد وينقق التكبير 

لطريقة العرض في اطار 

 التوضيح

 

أداة الرسم البياني 

 الرادار
يخلق مقارنه بين مجموعات 

القيم في نقا  معينه من من 

الزمن أو فئات معينه ويتم 

عرضها في شكل دائري 

ويسمى أيضا رسم على 

 شبكة الانتر نت

 
 

 أداة اليد

لتحريك لوص الرسم ضمن 

 اطار التوضيح

 

 أداة التبليط

يضبط شبكات الصفحات 

للتحكم بالعمل الفني حيث 

 يظهر على صفحة المطبوع
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 اتوالرسوم الأشكال

 إنشاء الأشكال الأساسية:

يمكن إنشاء الكثير من العناصر في برنامج أدوبي إليستريتور انطلاقاً من الأشكال  

الأساسية ثم تحرير تلك الأشكال للحصول على أشكال جديدة. حاول أن تنشئ شعاراً 

 بسيطاً باستخدام أدوات الأشكال الأساسية.

جمة والدائرة وحدد بهما أشكالًا مختلفة على استخدم أدوات الرسم المستطيل والمربع والن 

 سطح صفحة الرسم.

 

 توحيد الأشكال:

ليستريتور العديد من الأدوات والأوامر التي تسمح لك بتعديل يتضمن برنامج أدوبي إ 

تغير أشكال العناصر عن طريق إضافة  (Path Finder)أشكال العناصر. إن أوامر اللوص 

 واقتطاع الخطو  الخارجية أو المسارات حولها.

 تدوير العناصر:

من نقطة المبدأ وتدوير الزاوية  Transformيمكنك تدوير العناصر باستخدام اللوص  

 يمكنك أيضاً تدوير العناصر باستخدام أداة التدوير لسحب العنصر أو لتعيين زاوية دورانه.و
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 ارسم شكلًا بسيطاً وحاول تدويره بإحدى الطريقتين الآتيتين:

o  لتحديد  ما نقر في زاويةالأدوات، أحدّد أداة التدوير من مربع ثم حدّد الشكل المراد دورانه

حول نقطة تتم الحركة  يفمركز للدوران حوله، وابدأ بسحب الشكل المحدّد. لاحظ ك

 .المبدأ

o نقر نقراً مزدوجاً على أداة التدوير في مربع الأدوات ليظهر حدّد الشكل المراد تدويره، ثم أ

لتدوير  Ok. اكتب قيمة زاوية التدوير المطلوبة وانقر Rotateمربع الحوار الخاص بالدوران 

 العنصر حول مركزه.

 

 عكس العناصر:

يتم عكس العناصر بقلبها حول محور عمودي أو أفقي غير مرئي. نسل العناصر أثناء  

يؤدي لإنشاء صورة معكوسة عنها وبشكل مشابه لعمليتي تحجيم العناصر وتدويرها قلبها 

يمكنك تعيين نقطة المبدأ التي يتم عكس العنصر بالنسبة لها أو استخدام نقطة مركز 

 العنصر افتراضياً.

 ارسم عنصراً بسيطاً وحدّده باستخدام السهم من مربع الأدوات. 

وانقر على  (option)ربع الأدوات. اضغط على المفتاص حدّد أداة العكس الموجودة في م 

الحافة اليمنى للعنصر الذي رسمته، إن النقر على حافة العنصر يعين نقطة المبدأ وضغط 

في مربع حوار  Reflectأثناء النقر يعرض مربع حوار الانعكاس  (option)المفتاص 

بالزاوية ثم انقر على الزر في حقل النق الخاص  %90الانعكاس، اختر عمودي وسجل قيمة 

(Copy). 
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لعكس العناصر المحددة وذلك باختيار  (Transform)يمكنك أيضاً استخدام اللوص  

 الأمر قلب أفقي أو قلب رأسي من قائمة اللوص.

 

 المسارات

 أو المستقيمة مقاطع من المسار يتكونمسار،  يسمى خط بإنشاء تقوم ترسم، وأنت

 التي تحمل الدبابيس مثل تعمل والتي ربط، تعمل بنقا  مقطع كل ونهاية داية. بالمنحنية

 سبيل على) نهاية أو بداية ) بدون مغلق المسار يكون أن الممكن من، مكان في سلك

  ).المتموج الخط المثال ) سبيل مميزة على نهاية نقا  ذو مفتوص أو ) الدائرة (المثال،

 خطو  نهاية في الاتجاه نقا  فإن الربط نقا  بسحب المسار شكل تغيير يمكنك

 .نفسه المسار مقطع أو الربط، نقا  عند تظهر التي الاتجاه

 

 المسار مكونات

 محددة إرساء نقطة  .ب                       ) صلبة (محددة نهاية نقطة. أ  

  منحنى مسار مقطع .د                          محددة غير إرساء نقطة . ج 

 اتجاه نقطة .و                                            اتجاه خط .هد  
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 نقطة الناعمة في والنقا  الزاوية نقا  :الربط نقا  من نوعان للمسارات يكون أن يمكن

  متصل كمنحنى المسار مقاطع تتصل الناعمة ، النقطة تمامًا في اتجاهه يغير المسار الربط،

 لأنوع رسمت وإذا ،الناعمة  والنقا  الزاوية من تراكب أي باستخدام مسار رسم يمكنك

 .تغيير ه دائمًا يمكنك النقا ، من الخاطئ

 

 مسار على النقاط

 والناعمة الزاوية النقا  من تراكب .ج         ناعمة نقا  أربعة .ب      زاوية نقا  أربعة .أ

 النقطة تصل بينما منحنيتين، أو مستقيمتين نقطتين أي الزاوية نقطة تصل أن يمكن

 مستقيمة مقاطع بين  الزاوية نقطة تصل أن يمكن،منحنية  مقاطع نقطتين دائمًا الناعمة 

 .منحنية ومقاطع

 

 الرصاص القلم أداة باستخدام تحرير المسارات

 على وأشكال حرة خطو  وإضافة الرصاص القلم أداة باستخدام مسار تحرير أي يمكنك

 .شكل أي

 الرصاص القلم أداة باستخدام مسار إضافة

 .موجود مسار حدد .1

 . الرصاص القلم أداة حدد .2

 .المسار نهاية نقطة على الرصاص القلم رأس ضع .3



 لمناهجلالإدارة العامة   التصميم بالفوتوشوب والإليستريتور

 

 

56 

 .المسار لإكمال اسحب .4

 

 الرصاص القلم أداة باستخدام مسارين توصيل

 حول اسحب أو العالي مفتاص على الضغط مع نقر)أ  المسارين كلا حدد .1

 .التحديد( أداة باستخدام الاثنين

 . الرصاص القلم أداة حدد .2

 المسار باتجاه السحب وأبدأ واحد، مسار من تبدأ أن تريد حيث المؤشر ضع .3

 .(Ctrl)  مفتاصمع  الآخر مضغوطًا

  فتاصم أطلق ثم الماوس، زر أطلق الآخر، المسار في النهاية نقطة إلى اسحب .4

(Ctrl). 

 

 الرصاص القلم أداة باستخدام المسارات تشكيل تغيير

 .تغييره تريد الذي المسار حدد .1

 .رسمه لتعيد المسار بقرب أو على الرصاص القلم أداة ضع .2

 تختفي عندما النهاية نقطة من قريب بأنك تعرف أن يمكنك الأداة من .3

 .المرغوب بالشكل المسار يصبح حتى الأداة اسحب

 .مغلق لتحرير شكل الرصاص القلم أداة استخدام

 القلم أداة باستخدام الرسم

 القلم  أداة باستخدام مستقيم خط مقاطع ارسم

 القلم أداة بنقر يصنعو المستقيم الخط هو القلم أداة باستخدام رسمه يمكنك مسار أبسط

 مستقيمة مقاطع خطو  من مصنوع مسار بإنشاء تقوم النقر، باستمرار ،ربط نقطتي لإنشاء

 .زاوية عبر نقا  متصلة
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 .مستقيمة مقاطع ينشئ القلم أداة نقر

 .القلم أداة بتحديد قم .1

 لا، ربط نقطة أول لتعرف وانقر المستقيم، المقطع يبدأ أن تريد حيث القلم أداة ضع .2

 .المسار مقاطع بالسحب لمعاينة تقوم

 العالي مفتاص على الضغط مع )انقر المقطع ينتهي أن تريد حيث أخرى مرة انقر .3

  45)بمضاعفات المقطع زاوية على للحفاظ

 .إضافية مستقيمة مقاطع أجل من الربط نقا  لضبط النقر في استمر .4

 تصبح .محددة أنها إلى مشيرة صلب، مربع هيئة على دائمًا ربط نقطة آخر تظهر .5

 من نقا  المزيد بإضافة تقوم وأنت محددة، وغير مجوفة، مسبقًا تعرفي   ها تم التي النقا 

 :التالية الخيارات من أي بتنفيذ المسار أكمل .الربط

 القلم أداة باستخدام منحنيات رسم

 الاتجاه خطو  وسحب المنحنى، يتغير اتجاه حيث ربط نقطة بإضافة منحنى بإنشاء تقوم

 في أسهل المنحنيات ، المنحنى شكل الاتجاه خطو  وميل طول ويحدد المنحنى تشكل التي

 نقا  أقل باستخدام رسمتهم إذا أسرع وطباعتهم بعرضهم نظامك يقوم أن يمكنو التحرير

  .ممكنة ربط

 بدلًا من ،أيضًا المنحنى في مرغوبة غير يؤدي لنتوءات أن يمكن النقا  من العديد استخدام

 خطو  وزوايا طول بضبط المنحنيات تشكيل وجرب متباعدة، ربط نقا  ارسم ذلك،

 .الاتجاه

 .القلم أداة بتحديد قم .1

 .مضغوطًا الماوس زر وابق المنحنى، يبدأ أن تريد حيث القلم أداة ضع .2

 .الماوس زر أطلق ثم بإنشائها، تقوم التي المنحنى مقطع ميل لضبط اسحب .3
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 القلم أداة مؤشر ويتغير الأولى، الربط نقطة بالسحب تظهر تبدأ أن بعد فقط المؤشر يتغير

 ) .سهم رأس إلى

 تخطط التي التالية الربط نقطة إلى المسافة ثلث حوالي الاتجاه خط بتمديد قم عامة، بصفة

 مضغوطًا العالي مفتاص الحقًا ابق الاتجاه خط جانبي أو جانب ضبط يمكنك) .لرسمها

 45 بمقدار زيادات على للحفاظ

 
 منحنى في الأولي النقطة رسم

 الاتجاه خطو  لتمد السحب .ج    الماوس( زر ضغط مع (السحب بدء .ب    القلم أداة ضع .أ

 :التالية الأمور بأحد وقم المنحنى، مقطع ينتهي أن تريد حيث القلم أداة ضع -4

 الماوس زر اتر  السابق ثم الاتجاه لخط المعاكس في الاتجاه اسحب

 

 فني عمل مسح 

 أي مسح لك تتيح، حيث المسار ممحاة أداة باستخدام الفني عملك من أجزاء مسحيمكنك 

 على الممحاة أداة استخدام يمكنك، و الهيكل عن النظر بغض الفني، عملك مساحات من

 .المتراكبة لمساراتأو ا المسارات

 
  المسار من أجزاء لمسح المسار ممحاة أداة مااستخد
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 Illustratorليستريتور مع رسوم إ Photoshopاستخدام صور فوتوشوب 

الصور إلى ملفات برنامج  يمكنك بسهولة إضافة صور تم إنشاؤها في برنامج تحرير 

ليستريتور. فالحصول على مجال واسع من النتائج الإبداعية يمكنك من تركيب الرسم إ

الأعمال الفنية المصممة في برنامج الرسم إليستريتور مع صور من التطبيقات الرسومية الأخرى 

بطرق متنوعة. فمشاركة العمل الفني بين عدة تطبيقات تسمح لك بتركيب الرسومات 

 غرافية مع الرسم بالخطو .متدرجة الألوان والصور الفوتو

 ولإدراج ملف فوتوشوب في مستند إليستريتور اتبع الخطوات التالية:

 .(File)من قائمة  (Place)اختر الأمر  -1 

 ستظهر لك نافذة يمكنك من خلالها تحديد الصور المراد إدراجها والملف المحفوظة به. -2 

لتظهر لك على مستند  Okأو  (Place)انقر على الصورة المراد إدراجها ثم انقر  -3 

الرسم إليستريتور حيث يمكنك التعامل معها بجميع إمكانيات برنامج الرسم من 

 تكبير وتصغير ودوران وانعكاس... إلخ.

 
 

 حفظ الصور:

 بصيغ متعددة حسب الجودة المطلوبة.وتصديرها بعد الانتهاء من العمل بإمكانك حفظ الصور 

 



 لمناهجلالإدارة العامة   التصميم بالفوتوشوب والإليستريتور

 

 

60 

 ــعالمراج
 

 المرجع الرقم

 .1معالجة الصور بالحاسبحقيبة  1

 .1تقنية التصميم والتجهيز الطباعيحقيبة  2

 .2حقيبة تقنية التصميم والتجهيز الطباعي 3

 سلسلة تعليم الجرافيك 4

5 https://www.adobe.com 

 

 

  


